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Picture resizer free
This app allows you to resize an image to whatever size you like (with limitation), quickly and easily. You can specify the output format using one of the following four units of measurement: pixels, millimeters, centimeters, inchesTo preserve aspect ratio just tap on the chain icon between width and height input fields.Image Size gives you the option of
saving, emailing, printing or sharing the final image.Resize your image in just four easy steps:- Open an image or take a photo- Enter your desired output size- Crop the image with your fingers using multitouch gestures- Save / print / send / share image May 26, 2021 Version 11.3 The new version supports multitasking. Ok first, let’s just take a sec to
appreciate the app and the people that made it.... now that that’s done... I would just like to say this app is a total game changer! I am an artist and I have just started selling my digital art and graphic design on redbubble, however I am very broke and so I have to use my phone to create my art bc I can’t buy a computer or iPad, but when trying to
upload to redbubble I noticed my design was incredibly small and wouldn’t appear on their products the way I would like it too. So I checked the app that I use to make art (ibis paint x) and noticed that the canvas size was really small and limited, so I took to the App Store for a photo resizer. I tried several apps but for most of them you had to pay for
it (even it said it was free) or it wouldn’t let me resize my art big enough (too limiting) then I tried this app. TOTAL FREAKIN GAME CHANGER!! The features are flexible and free! And even tho their is ads they are very short and often so entertaining! Today I made my first sale on redbubble so I just thought it would be fair to leave a nice review for
this absolute god-send of a app! Tysm!❤❤❤❤❤ Update Review: The developer contacted me about the app. Telling me the app doesn’t cut of pictures. I just have to hit the chain & it turns blue. I don’t think they really get the idea of picture resizing. I want to resize the picture to what size I want without the image being cut off. Not have the app tell
me what size the photo should be by what numbers I put in either spot. I need specific sizes so that chain option isn’t working for me. The picture ends up being to big. I end up having to use paint for certain pictures. I really hope they update it and make it more like paint. Where you can change pixels, MM, CM, and inches without what I said before
losing part of the image. The chain only works if you don’t need a specific size. So my review stays the same.First Review :So I have the full version app. But I feel like things need to be updated. When you resize a picture you don’t want half of it to be cut off. That isn’t really resizing it? Of course it making it bigger but it’s leaving apart of the bottom
of the picture and side of picture cut off. They really need to fix this because it defeats the purpose of the app. I might as well get a refund and just use paint to resize my pictures which enlargers the entire photo without cutting something out of it. Thank you for your feedback. Like the description says: “To preserve aspect ratio just tap on the chain
icon between width and height input fields.” If you activate the chain icon and its color is blue, than the app will actually resize the image. You can not resize an image to what ever size you want without cropping or stretch/shrink. You can only actually resize image if you preserve aspect ratio of the image. I’ve been using this app for some time and
it’s been great for printing exactly the size I want to transfer a digital drawing or tracing to paper for watercolor, etc. Suddenly, it will no longer print the size I specify. Is this because of the update to iOS 11? What can I do to get this back? I’m using an iPad Pro and an iPad mini 4. If I could resolve this, it would return to a 5-star app, in my opinion.
But it’s useless to me if it won’t print the specified size. Thanks.I’m using the print button in the app, which has always worked fine, over my home WiFi. I tried to print approximately 8x10, 5x7, and 4x6, and none came out the right size. I say approximately because it depends on the size of the image with the constraint for keeping the original
proportions turned on. The only new thing on my end is iOS 11. I also made sure to update the app and try before writing my review. Thanks for your attention to this.Update: I’ve gotten it working again and I have to say their customer support is excellent. Highly recommended. Dear Boy Howdy Game Fan, I just printed from iPad Pro with iOS 11
and iPhone 6s with iOS different images with different sizes, with the option for keeping the original proportions turned on and off. All prints come out in the correct size. Is the print correction factor in the app settings perhaps not zero? Or maybe something is wrong with the printer? Please try to print with another app. I'm sorry I can not help you.
The developer, Vitalij Schaefer, indicated that the app’s privacy practices may include handling of data as described below. For more information, see the developer’s privacy policy. The following data may be used to track you across apps and websites owned by other companies: The following data may be collected but it is not linked to your identity:
Privacy practices may vary, for example, based on the features you use or your age. Learn More Developer Website App Support Privacy Policy ImResizer.com Today’s mobile devices take incredibly beautiful photos, but all that detail comes at a price — size. Therefore, you need a good image resizer app that will re-size your photos instantly without
losing any quality.The Problem: Great Pictures Sized Too LargeLet’s face it; our entire lives are now cataloged digitally due to mobile devices everywhere. That means a lot of photos, and because of the high level of quality, these photos have gotten huge! Most pictures taken on a typical phone camera are at least 2000 pixels wide and some clock in
much larger.The problem is that many of us post regularly to social media, and these photos are too big to fit the platform’s requirements. Therefore, every photo you take, before uploading it to Facebook, Instagram, or other social media sites, has to be cut down and sized accordingly.The Solution: Free Photo Resizer AppsThe good news is, there are
dozens of photo resizer apps out there to make that job quick and easy. Most of them are free but may include some in-app purchases such as additional filters or features to enhance your photo editing capabilities. If all you want to use it for is to resize your pictures for social media, most free offerings will suffice.Below, you’ll find our top five free
image resizer apps of 2020: Searching for how to resize images without losing quality? Follow our step-by-step guide on how to do it at no time.What Features Make a Good Picture Resizer App?When evaluating what makes a good image resizer app, good, we had to look at a few different things. Most image resizers will, of course, allow you to resize
your image. However, if you know anything about the way image sizing works, you know that it’s not always that easy.Sometimes a photo doesn’t fit well into the new chosen size. In that case, you need to crop or fill that size canvas with a portion of your photo. These types of things are essential and shouldn’t be overlooked when picking an image
resizer. Other features we like to see in a good, free photo resizer are:A rotate feature.Easy-to-use interface.Adjustments for color, light, and balance.Filters for fun to enhance already great photos.Blemish correction or retouching for red-eye.Special effects.Presets for size or combo effects.Available on both Apple and Android devices. 1. Resizing.app
One of our favorites is an online image resizer, called Resizing.app. The company has a straightforward website and process to resize images online within seconds. One of the coolest features is the ability to export your newly sized image into a different format.Resize your images here ↓Add to ChromeResizing.app couldn’t be easier to use. You
simply drag and drop your images into the box on the home page. Then you select how you want to resize your image (width only, height only or custom).You can choose to optimize your image for quality assurance and then just pick your new file format (jpg or png). Once you hit the save button, your new image is saved to your computer. Voila’ all
done. No frills but also no hassles. Unfortunately, this online service does not have any additional photo editing capabilities to go along with resizing. But hey! It’s free, and we like free and simple.If you resize your images and photos regularly, we highly recommend you to add the Resizing extension to your Google Chrome; it is also entirely free.2.
Photoshop Express: Photo EditorClearly, a lot of people like and use this app. Although Adobe is not often known for ease-of-use with their applications, we found this photo editor to be very easy to use.Adobe makes it a snap to quickly resize your images using templates for many popular social media platforms like YouTube, Facebook Cover photo,
ETSY cover photo, Pinterest, and more. This app also supplies a bunch of custom sizes and device options for sizing. However, the one negative is you can’t specify your own size in pixels or inches. For us control-freaks this is a big deal. That being said, Photoshop Express: Photo Editor is truly a full-featured, free photo editor. Not only do they pack in
some great special effects to turn ordinary photos into masterpieces in seconds, but they also check all our boxes with rotation, color and brightness controls, photo retouching, the ability to add text and much more!This is a great application but might be more than you need if all you want to do is resize your photos. Keep in mind though, it is
completely free so if you don’t mind preset sizes, this one is a gem.User ratings: 4.8 stars from 480k Apple users. 3. Image Size Photo ResizerThis photo resizer app is fantastic in so many ways. First, the interface is super easy to use. You don’t have to guess where to go to start editing. One of the most delightful features is that you can enter in an
exact size in pixels, mm, cm or inches, and your photo is instantly resized.This one also includes tools like color overlay, filters to enhance your photo, adjustments for color and brightness, fun effects, blur, and focus, flip, and you can even draw on your images to add more panache. The downside to Image Size is that the free version includes ads and
you have to watch a 30-second ad before saving your edited image. However, this app is so good; we think it’s worth purchasing the pro version.User ratings: 10.9k users 4.7 stars on Apple, 4.3 on Android. 4. Instasize Photo EditorUsed by almost 150,00 people, this app is very easy to use. It opens to a white screen with a black plus button. Just tap
the plus to select a photo from your device and then start editing. The built-in filters are stunning.We also love their preset crop sizes for Instagram, Facebook, Pinterest, and Twitter. It’s a breeze to navigate and change settings for exposure, contrast, Lux, brightness, sharpness, and dozens of other settings. You can also add text (using different
fonts) and a colored border. What we don’t like about Instasize is the free version is good for only seven days, and then you must buy the full version to continue using it. What this app lacks in retouching and effects, it makes up for in easy resizing for photos to post on social media. 5. ReSIZER - Simple Photo ResizerIf you want the simplest, free
picture resizer on the market, then this one is for you! The plain interface offers a big plus button on a white screen to begin. Once you select your image, you have only three options: rotate, crop, and resize.That’s it! Using this app is so quick and easy. It does the job without any fancy add-ons, but it does allow you to share your resized image with
others. Other than having very few options to choose from, the only other downsize to Resizer is that it only works on Apple phones. Sorry, no Android version is available yet.ConclusionAlthough we reviewed a few solid options for image resizing, it’s really a matter of personal taste. If you want no-frills and no hassle, Resizer is your tool. If you are on
the computer and don’t have access to your images on a mobile device then Resizing.app is definitely the way to go.Our favorite pick for the mobile device apps would have to be Adobe’s Photoshop Express. The combination of features and powerful effects was intoxicating and it’s free to boot!However, Image Size came in at a close second, and we
love the ability to micro-manage the image size using a number for height and width.Related Articles: Quickly resize a photo for Facebook, a profile image for LinkedIn, a banner for Twitter, or a thumbnail for YouTube. You can even resize a screenshot or shrink a hi-res photo to help your blog or web page load faster.Create Story1080 x
1920instagramCreate Square1080 x 1080instagramCreate Portrait1080 x 1350instagramCreate Landscape1080 x 566instagramCreate IGTV Cover420 x 645instagramCreate Post1200 x 628facebookCreate Profile Cover1640 x 624facebookCreate Page Cover1200 x 675facebookEvent Cover1920 x 1005facebookCreate Thumbnail1280 x
720youtubeCreate Post1024 x 512twitterCreate Card1200 x 628twitterCreate Header1500 x 500twitterCreate Story1080 x 1920snapchatCreate Profile400 x 600twitterCreate Widescreen16:916:9 Getting files from Drive Getting files from Dropbox Uploading file 0 of 0 Time left - seconds - Upload speed - MB/S Resizing images... Woops! Something is
wrong with your Internet connection...
LunaPic > Edit > Resize Image Resize or Scale Image Use Lunapic.com to resize, enlarge, shrink or scale an image instantly Use the form above to choose a image file or URL After uploading, choose the width or height of the image. You can also drag the corners of the image to resize it. In the future, use the
menu above Edit -> Resize Image You can also try Scale Image Tool for proportional scaling. Example of Resize tool Edit this picture Your company’s photos are critical for earning customer trust and making more sales. In one study, 91% of consumers said that they prefer visual content over static, text-based information. . That’s why it’s important
to make sure you use beautiful, high-quality photos that are the right size for your site and social media platforms. If you don’t have graphic design experience, don’t worry. There are dozens of free tools to resize images online. Moreover, we created a product photography course that can help you to take stunning product photos only with your
phone. Good use of images can drive more traffic and revenue, while bad use of images can kill your sales. Hopefully, the tools we’ll mention will help you create the right images for your digital properties. In this article, we’ll discuss 12 top tools to help you resize your images for free online. You can use these resources for product photography on
your store listings, blog images, social media profile images and posts, and more. Remember that you can’t use a single image without resizing it on every online channel. For instance, Facebook, Instagram, and Twitter have different image dimensions that you need to follow. Fortunately, adjusting image dimensions is a breeze with these tools. Don’t
wait for someone else to do it. Hire yourself and start calling the shots. Get Started Free 1. Free Image Resizer: BeFunky BeFunky is a great free image resize tool that offers a lot of options. You can resize your image by width or height or by percentage scale. For example, if you know you need your photo to be 500 pixels wide, you can type that into
the “Width” field. It will automatically choose the height so that the image isn’t distorted.If you want to choose width and height yourself, just uncheck the “Lock Aspect Ratio” box. Be careful, as this can make the photo quality worse when the ratio changes.You can choose basic photo resizing and editing for free. If you want more options, you can
upgrade to BeFunky premium for a fee. This will get you access to options like photo filters and effects, touch-ups, frames, text, and more.Best for: Quick and simple photo resizing.2. Bulk Image Resizer: B.I.R.M.E B.I.R.M.E. stands for “Batch Image Resizing Made Easy.” This bulk image resizer can help you resize several images at one time, instead
of doing them one by one. You can also add a border to each photo. Just choose how many pixels thick you want it to be.One of the best features of B.I.R.M.E. is that you can preview the photos before you’re done, so you know how they’ll look. This can make the editing process faster and easier.Best for: Resizing multiple images at the same time.3.
Resize Image Online: Free Image & Photo Optimizer This image resizer tool allows you to give the perfect size to your digital images. Created by Shopify, Free Image & Photo Optimizer lets you add your photos (maximum 6) by dragging them to the tool’s interface or uploading them from your device. Then you choose what dimensions you want to
resize the images to. Options include Compact (1024*1024 pixels), Medium (2048*2048 pixels), and Large (4472*4472 pixels). The tool is quite simple to use. There are no complex settings, and you can quickly resize the images in different dimensions. Whether you’re resizing for a social media update, a newsletter, or a product image for an
ecommerce store, simple and fast image resizing makes things convenient. Best for: Resizing images in different dimensions quickly.4. Resize Multiple Images: Online Image Resize This simple image resizer tool is great if you find some online image resizers confusing or difficult to use. There’s just one option: choose one or more photos, and then
choose the width that you want all of them to be. The minimum is 16 pixels, and the maximum is 1024 pixels.Online Image Resize will automatically change all photos to the width you specify. Then you can edit individual files by cropping, rotating, mirroring, or resizing more. When you're done, you can download them individually or all together in a
ZIP file. Sweet!Best for: Simple image resizing. Social Image Resizer Tool is a brilliant tool for all your social media image needs. Once you upload your photo, there’s a dropdown menu where you can choose what you want to use the photo for.Options include:Facebook Cover PhotosCover and profile photos for LinkedIn, Twitter, and GooglePinterest
and Instagram thumbnails and Lightbox imagesYouTube channel art and custom video thumbnailsAnd moreYou just select the option you want, and the tool will let you crop and resize your image until it fits the dimensions of your choice.Note: the maximum file size is 2 MB. If your original photo is larger, you may want to use a different resizer or
image compression tool first to bring it under 2 MB and then use Social Image Resizer to make it the right size for social media. Keep reading for more info about compressor tools.Best for: Resizing images for social media.6. Free Image Resizer: Simple Image Resizer They weren’t lying when they named it “Simple Image Resizer.” To use the tool,
pick an image, choose if you want to resize based on dimensions (pixels) or percentage, choose the pixels or percentage number, and then click Resize.To prevent a distorted or weird-looking final result, make sure to enter only one dimension. Doing this prompts the tool to keep proportions similar.You can only make a photo smaller, not larger. But
it’s important to note that making an image larger will cause the quality to be worse. So you should try to avoid this anyway.Note: this tool also allows you to resize images into different formats.. For example, you can convert JPG images to PNG files using this tool.Best for: Simple image resizing and converting images into different file types. This
tool is similar to Social Image Resizer Tool (#5 in this list) because it helps you resize images for social media platforms like Facebook, Twitter, and Instagram. However, it has fewer options.Photo Resizer also offers extra tools similar to Microsoft Paint. You can rotate or flip an image, and free draw on the photo or draw circles or rectangles. These
features can be handy when you want to draw a visitor’s attention to a certain part of a photo. You can also add text, like a caption or headline.The Sharpen option in the ‘Tools’ dropdown menu can help make a blurry image look clearer, enhancing image quality.Best for: Resizing images for social media.8. Resize Multiple Images: I Love IMG Another
tool to resize multiple images, I Love IMG makes the process easy. Upload all of your images at once, then choose if you want to resize by pixels or percentage.The By Pixels option offers a helpful feature, a checkbox that says, “Do Not Enlarge If Smaller.” For example, say you want all photos to be 800 pixels wide. If some of your photos are 700
pixels wide, it won’t make them bigger. This prevents them from becoming blurry and pixelated, so you get high-quality images to use on your website.Best for: Resizing multiple images at the same time.9. Free Image Resizer: ResizePixel This is another simple and clear-cut tool that also lets you resize images. Choose the width and height in pixels,
then choose if you want the final image to be compressed without losing the quality, or resize the image in kilobytes or megabytes. You can also choose to convert the files to JPG, PNG, GIF, WEBP, TIFF, BMP, or just keep them the same.Keep in mind that the automatic compression mode will reduce the image size without visible loss of quality. If you
need more control over the file size, you can reduce the image to kilobytes or megabytes. It is worth mentioning that image size is important because heavy images can slow down your website’s loading time, thus reducing the conversion rates.Best for: Simple image resizing.10. Bulk Image Resizer: Bulk Resize Photos Bulk Resize is simple and easy
to use. The menu is on the screen’s left side, and the screen will change based on your choice. Options include scale by percentage, longest side, width, height, and exact size.‘Longest side’ means you can choose a set amount of pixels for the longest side of each photo. For example, say you choose 800 pixels. Photos that are landscape/horizontal will
have a new width of 800 pixels. Photos that are portrait/vertical will have a height of 800.This option is helpful if your photos aren’t all the same layout.Best for: Bulk image resizing.11. Facebook Image Resizer: Resize for Facebook Resize for Facebook is a no-frills online tool for resizing and sharing photos on Facebook. By default, the social media
platform displays your image in a small size, and sometimes it resizes the photo itself to fit the required dimensions. However, leaving the task to Facebook often results in images that don’t look the best. By resizing your images through this tool before you upload them, you know exactly how they will appear.With Resize for Facebook, you can also
upload the new images directly on your profile. Doing is pretty simple: choose your image, click the Resize button, get your mobile uploads email address from Facebook, and write the caption for your image. The tool supports images up to 6Meg, which means you can also upload images from your digital camera.Best for: Resizing photos for
Facebook.12. Free Image Resizer: Crello Crello is a powerhouse in the online photo resizing field. You can use it to modify the size of a JPEG, PNG, or JPG photo. The tool offers resizing for various blog illustrations, social media networks, ad or print format – just select the one you need in the preset menu. Alternatively, you can enter the dimensions
of your final image manually in inches, centimeters, or pixels.The tool also makes resizing images a breeze. You just have to upload an image to Crello, insert it in the blank page, and select ‘Resize’ from the top right corner of the tool’s interface. Getting around Crello is easy, especially for Canva users, as it has a familiar feel to the graphic design
tool.Best for: Resizing images for various digital channels at once. How to Resize Image Without Losing Quality OnlineWhen you use free image resizing tools, you might find that the image’s quality is worse. This can be seen when the photo becomes blurry, pixelated, or distorted. It’s important to make sure that the tool you use doesn’t lower the
image’s quality. This can harm your store’s performance.Many of the free tools you can find online will make it a priority to keep high quality. This can be seen in some of the tools we discussed, which will ask you what quality you want your final image to be, on a scale of “low to high” or up to 100%.For example, the free image resizer B.I.R.M.E. has
this “quality setting” option that lets you render images with 100% quality. We recommend using this option for smaller files.You can also find image compressor tools online to help resize images. For example, the free image resizer tools I Love IMG and Simple Image Resizer that we discussed above have the option to compress an image.Optimizilla
and Compressor.io are two other great online image compressor tools. Optimizilla lets you compress multiple images, while Compressor.io compresses one at a time. How to Resize an Image in PhotoshopIf you have Photoshop, it’s an ideal way to resize an image. It’s quick and easy, and you have more control over the process. Even if you don’t have
Photoshop, you can sign up for a 2-week free trial to see how to use Photoshop and if it’s worth the investment for your company.Here is a step-by-step tutorial on how to resize an image in Photoshop:1.In the menu, click File → Open. Choose the image you want to resize. 2. In the menu, click Image → Image Size. If you have a certain width or height
you want the photo to be, type in the number in the Width or Height box. Photoshop will then automatically choose the other number so that the image isn’t distorted (like the other tools we discussed above). In the dropdown box next to the Width and Height fields, you can also select Percent if you want to resize the image that way. For example,
80% or 150% of the original image’s size. Click OK when you’re done. 3.In the menu, click File → Save, and you’re ready to go. If you’re interested in learning how to use Photoshop, we have a Photoshop Tutorial for Beginners.While it’s easy to overlook, ensuring an image is the right size and quality is one of the most important parts of building your
online presence. Quality photos create a positive impression of your company. In some cases, photos can be the difference between a new customer and someone who immediately leaves your website.There are dozens of tools to resize images online, free of charge. Even if you have no experience, you can find a quick and simple image resizer that can
do the job in a few clicks. If you have a higher level of skill, you can use a tool that has more custom options, or you can learn how to resize an image in Photoshop.To summarize, if you’re looking for:A simple image resizer tool, you can choose from BeFunky, Online Image Resize, Simple Image Resizer, ResizePixel, Free Image & Photo
Optimizer,Crello.An image resizer tool for social media, you can choose from Social Image Resizer Tool, Photo Resizer, Resize for Facebook.Resizing more than one image at the same time, you can choose from B.I.R.M.E, I Love IMG, Bulk Resize Photos.Get started today optimizing your photos and making your website beautiful and attractive to
visitors.Do you have a recommendation for a free image resizer or bulk image resizer that we didn’t list in this article? We’d love to hear from you in the comments below.Want to Learn More?
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